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 1    

Using The Tab Key To Move To The Next  Input Cell  
 

     
Question: You may have a spreadsheet set up with a number of data inpu t cells. Wouldn't it be nice if 
the user could just press the Tab key to jump to the next input cell?   

Answer: This type of thing is fairly easy to set up . The key is to unlock the input cells, and then protect 
the worksheet.  
 
Process (Excel 2007 and Excel 2003):  

Here is how to do it:  

1. Select all of the input cells on your worksheet. (To select non -adjacent cells, hold down Ctrl  while you select 
the cells)  

 

2. Choose Home Tab, Cell Group, Format Drop Down arrow, Format cells (2003 ð Format, Cells)  to display the 
Format Cells dialog box 
  

3. Click the Protection  tab and remove the check  mark from the Locked check box  

  

4. Click OK 

Keep in mind that all cells are loc ked by default. But also remember that locking or unlocking cells has no effect unless 
the worksheet is protected. Select the Review Tab, Change Group, Protect Sheet Icon (2003 - Tools, Protection, 
Protect Sheet)  to protect the worksheet. You can enter a p assword if you like.  
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 2007        2003 

When the sheet is protected, you'll find pressing Tab moves the heavy-bordered active cell indicator to the next 
unlocked cell. Be aware that this does not prevent the user from selecting unlocked cells using the cu rsor keys. 

 

 

 2  

 Trapping Error Messages 
 

Question: If you've worked with formulas, you've probably encountered the dreaded formula error.  
Rather than return a numeric result, the formula cell displays a weird message such as #VALUE! or  
#DIV/0!.  

Answer: Most of the time, this means you need to track down the source of the error and fix it. But 
sometimes a formula error simply means that the data used by the formula is not yet available. For 
example, say you run a small telemarketing company. You might  have a spreadsheet set up to track 
your daily sales as a percentage of calls made.  

Process (Excel 2007 and Excel 2003):  

 



 

 

8 
 

 

 
1. The formulas in column D do the calculations that c ome up with the percentages. For example, cell D4 

contains the formula =C4/B4. The formula in D4 was simply copied down the column to handle the other 
days 

 
2. The formula does its job well --as long as there is data to calculate. An empty cell (such as B9) is  treated as 

a zero, and division by zero is not allowed. As a result, Excel displays an ugly #DIV/0! error message, which 
makes your entire worksheet look like it was created by a novice  

 
3. You can avoid displaying formula errors by re -writing your formula t o use an IF and an ISERROR function. 

For example, =IF(ISERROR(C4/B4),"", C4/B4) displays a blank if the division operation results in an error 
(cell B4 is empty or contains 0), yet still displays valid results.  

4. Although this formula looks complex, when you  break it down, it's not that daunting. In plain English: If you 
get an error performing the formula, then display an empty string (that is, nothing); otherwise, di splay the 
result of the formula  

 
5. It's actually easy to adapt this technique to any formula y ou might have. The original formula serves as the 

argument for the ISERROR function, and it repeats as the last argument of the IF function, like this: 
=IF(ISERROR(OriginalFormula),"",OriginalFormula) 

 
6. If you prefer, you can replace the empty string ("") w ith other text of your choice --just make sure the text 

is enclosed in quote marks 

 3  

Date Calculations  & Formulas  

 
Question: Is there some kind of formula I can use to help me work out various dates I might need in  
Excel? 

Answer:  By using a simple (and  sometimes not so simple) formula, Excel can supply you with every kind 
of date you might need to display.  

Process: Tried and Tested in 2003 and 2007.  Here is what you can do:   

http://pcworld.com/howto/graphics/105312-10aol_excel_errors.gif
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Age Calculation 
Add Months (EDATE) 
Get Day 
Age Check 
Count Weekdays 

 

Age Calculation  

 
 
You can use DATEDIF as in =DATEDIF(A1,TODAY(),"y") or =DATEDIF(A1,NOW(),"y") 
 
An alternative to DATEDIF. 

=TEXT(IF(OR(MONTH(TODAY())>MONTH(A1),AND(MONTH(TODAY())=MONTH(A1),DAY(TODAY())>=DAY(A1))),(TODAY()-

A1)/365.25,(TODAY()-A1)/365.25-1),"0") 

 

Add Months (EDATE)  

 
 
This is an alternative to EDATE if you don't have the Analysis Toolpak installed.  

=IF(DAY(A1)<>DAY(DATE(YEAR(A1),MONTH(A1)+B1,DAY(A1))),DATE(YEAR(A1),MONTH(A1)+B1+1,0),DATE(YEAR(A1),MONT
H(A1)+B1,DAY(A1))) 
 
B1 = Months to add 
 
This formula avoids problems with different numbers of days in a month. It will either return the same day in the 
month added by B1, or it will calculate to the end of that month. (No overlapping into the month immediately after)  
or 

=DATE(YEAR(A1),MONTH(A1)+B1,MIN(DAY(A1),DAY(DATE(YEAR(A1),MONTH(A1)+B1+1,0))) 

 

 

Get Day  

 
 

Day of the Month                                Use =DAY(A1) to get the day of a date entered in A1.  

 

Weekday                                            Use =WEEKDAY(A1) then format as ddd or dddd 

 

or 

                                                          Use =TEXT(WEEKDAY(A1),"ddd") or =TEXT(WEEKDAY(A1),"dddd") 
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Age Check  

 
 
To see if someone is 20 years old or over use this formula (TRUE means that they are)  

=AND(ISNUMBER(A1),A1>=20)<DATE(YEAR(TODAY())-20,MONTH(TODAY()),DAY(TODAY()))) 

 

Count Weekdays  

 
 
Count remaining weekdays in a month  
 
Enter as Date  

=INT((DATE(YEAR(TODAY()),MONTH(TODAY())+1,0)-DATE(YEAR(TODAY()),MONTH(TODAY()),DAY(A1)))/7+1) 
 
It will give the number of remaining wee kdays (eg Saturday) of the date you choose for the current month, including 
the date entered in A1. Adjust to suit.  
 
A1 = Date 

 

 

 

http://www.alchemex.com/ProductDetail.aspx?Prod=TrainingEOS
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Customizing Validation Lists 
 

Question: I use validation lists, but I would like to add a second list, where the contents change based 

on the value chosen in the first list. How do I do this?  

 

Answer: Create a contingent validation list and the INDIRECT function.  

 

Process (Excel 2003 a nd 2007):  

 

Validation lists are very useful tools in Excel ð a drop down option allows you to select a value from a pre -defined range 

of values. But what if you want two lists ð the first could be a product category and the second list only showing you 

products from the category that you select? In this example weõll be using the following values: 

 

 
 

Steps described below relate to the data you see above. Thank you to Mike Perks from Port Elizabeth, South Africa for 

this Tips & Tricks topic suggestion.  

 

Excel 2003  

 

1. Select cells D1 to F1 

 

 
 

2. From the Menu bar, select Insert é Name é Define 
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3. In the ôNames in Workbookõ field, type in the word Categories. Note that in the ôRefers Toõ box, the cells you 

highlighted are listed in absolute reference format. Cli ck OK 

 

 
 

4. Select cells D2 to D4. These are the products that are in the Beverages category 

 

 
 

5. From the Menu bar, select Insert é Name é Define 
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6. In the ôNames in Workbookõ field, type in Beverages (i.e. the heading name of this category). Click OK 

 

7. Repeat this process for each of the categories:  

 

a. Cells E2 to E4 will be named Cereals  

b.  Cells F2 to F3 will be named Dairy  

 

8. Select cell A1, then from the menu bar, select Data é Validation 

 

 
 

9. In the ôData Validationõ box, make sure you are on the ôSettingsõ tab. In the õAllowõ field, select List  

 

 
 

10. In the ôSourceõ field, type in =Categories . This is the named range that will return all category headings. Click 

OK 

 

 
 

11. Cell A1 will now have a drop down arrow that will allow you to sele ct any of the category headi ngs 

 



 

 

14 
 

 

 
 

12. Select cell A2, then from the menu bar, select Data é Validation 

 

 
 

13. In the ôData Validationõ box, make sure you are on the ôSettingsõ tab. In the õAllowõ field, select List  

 

 
 

14. In the ôSourceõ field, type =INDIRECT(A1). The INDIRECT function will bring back the value of cell A1, which 

happens to be the name of the named range that you want to use. Click OK 

 

 
 

15. When you click OK, you may receive this error message:  
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This error will occur if nothing has been selected from the drop down list in cel l A1. If you receive this 

message, simply click Yes 

 

16. Cell B1 will now return a list based o n the selection made in cell A1  

 

 
 

 

 5 

 

Averaging A Non-Contiguous Range 
 
Question :      Is there a way to average a series of non -contiguous cells, excluding any cells that contain 

zero values? 

Answer :       Yes, by using the following formula.    

 

The evaluation done on each cell will return either a 1 (True) or 0 (False) depending on whet her or not the cell is equal 

to zero. The values are then added together, providing the necessary count of cells to average by for fruit sales.  
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Formatting  Year  Values Represented  As Decimals To Show Years & Months 

 
Question:   I have a year valu e represented as a decimal (e.g. 3.667 years). How do I change it to 

represents years and months?  

 

Answer: By using a combination of INT functions and concatenations  

 

Process (Excel 2003 and 2007):  

 

 
 

In the example above, a loan of $20 000 is to be repai d with a yearly repayment amount of $3 500 required. To know 

how many years it would take to pay back, simply divide $20 000 (A1) by $3 500 (B1) for an answer of 5.714285714 

years. How could we convert that to an answer that is represented as years and mon ths, which would be more 

meaningful? The following steps will use the layout represented above:  

 

1. Select cell D5 

 

2. In cell D5, type =INT(D2) and press Enter  

 

 
 

The INT function rounds a number down to a whole number. So in this insta nce, the result of INT(D 2) is 5 

 

    3. With cell D5 still selected, type in =INT((D2-INT(D2))*12)  and press Enter  
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D2-INT(D2) in the above formula subtracts the integer of the year number (5) from the actual year amount 

(5.714285714) which leaves the decimal points. The resul t is then multiplied by 12 to get a value for the 

correct number of months, which is then also then made an integer, giving the result of 8.  

 

Now that we know we can get the year value and the months value, it is time to combine them with some 

concatenatio n 

 

4.With cell D5 still selected, type in =INT(D2)&ó years and ò&INT((D2-INT(D2))*12)&ó monthsó and press Enter.  

 

Using the concatenation symbol & to combine our examples with the words ò years and ò and ò monthsó, we 

now have a complete answer (5 years an d 8 months ) 
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Date Validation 
 

Question: Can I check if a given date is within 90 days of todayõs date? 

 

Answer: Yes, using a combination of the TODAY() function with an IF() function  

 

Process (Excel 2003 and 2007):  

 

The TODAY() function returns the d ate as per the system date of the machine, using the YYYY/MM/DD format for the 

date.  

 

Once in a cell, this date can be used in calculations. The example in this tip and trick starts with the following 

information in Excel: a date listed in cell A1, with th e cell formatted to represent a date in DD -MMMM-YY format.  

 

 
 

1. Select cell B2 

 

2. Type in =TODAY() and press Enter  
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3. Select cell C2. Type in =B2-A1 and press Enter  

4. Select cell C2. Type in =(TODAY()-A1)>=90 and press Enter . This will return a FALSE value, as the result (35) is 

not greater than or equal to 90  

 

 
 

5. With cell C2 still selected, type in =IF(TODAY()-A1>=90,óYesó,óNoó) and press Enter  

 

 
 

The formula will subtract the entered date from todayõs date, then compare the value against 90. If the value is 

greater than or equal 90, the resul t will be òYesó, otherwise òNoó 
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Quick Way Of Creating A Chart 
 

Question: Is there a way to add a chart to some data without going through the Chart Wizard?  

 

Answer: Yes, using a keyboard shortcut  

 

Process (Excel 200 3 and 2007):  

 

There is a very simple keyboard shortcut that can create a bar chart graph with the push of one button. The example 

today will use a table containing six months worth of sales figures:  
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1. Using the table above, select cells A1:B7  

 

 
 

2. Press the F11 key 

 

 
 

A new chart is automatically added as a sheet, with this new sheet inserted in front of the sheet your data is on. You 

can further customise your chart by changing the colour and layout o ptions 

 

NB: the chart that is added is based on your default chart options.  
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Editing Selected Cells On A Protected Worksheet 
 

Question:  Would you like to be able to protect a worksheet but unprotect selected cells so they can be 

edited?  

Here is how:  

Excel 2007  

 

The cells you are going to "Unlock" are the cells you want to be able to edit.  

 

To Unlock the cells  

Select the cell you want to be able to edit (Hold down ctrl to select multiple cells)  

From the Home tab, in the Cells group, select the drop down arrow under Format  

Deselect òLock Celló (so you are now Unlocking the cell)  

 

OR 

 

If you prefer, you can right click on the selected cell/s  

Select Format Cells 

Select the tab at the top called Protection  

De-select the box for Locked  

Select OK 

 

Protect the worksheet  

From the Review tab, in the Changes group, select Protect Sheet  

Enter in the necessary (password etc)  

 

You will now only be able to edit the "Unlocked" cells  
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Formula To Find Duplicate Values In A Data Range 
 

Question: I have a list of inventory in my worksheet, is there a way of finding du plicate cells without 

having to manually sort and check each cell?  

Answer: You can find duplicates using the COUNTIF function.  

Here is how you can do it:  
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=COUNTIF($A:$A,$A3)>1 

=COUNTIF(column with duplicates, first cell in column)>1   

The CountIF will retu rn a Yes or a No to a question: the question in this instance is whether the number of times the 

value in cell A3 is counted is greater than 1. If it is, then itõll return Yes, otherwise False. 
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Switching Between Relative, Absolute, And Mixed References 

 
When making cells fixed in a formula, if you press F4 twice , it will make the row fixed.  If you press F4 

three times , it will just make the colum n fixed.   
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Generating Of Random Numbers For Testing Of Formulas  
 

Question: I need to create some ran dom numbers for testing of formulas. How can I quickly do this in 

Excel? 

 

Answer: One way to do this is using the RANDBETWEEN function  

 

Process (Excel 2003 and 2007):  

 

The RANDBETWEEN function allows you to generate a random, whole number inside of a range. The syntax is:  

 

=RANDBETWEEN(bottom,top)  

 

The bottom  parameter is the lowest number in the range you want to use, and top  is the highest number in the range.  

 

1. Select cell A2 and type =RANDBETWEEN(1,100) and press Enter  
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When you press Enter , a random whole number between 1 and 100 is generated (in this insta nce, the number 

32 is returned)  

 

2. Move your mouse to the bottom left hand corner of cell A2, click and hold on the AutoFill Handle , and drag it 

down to cell A7  

 

   
 

Youõll note that the moment you release the AutoFill Handle , all cells generated a random number, including 

cell A2 ð it has changed from 32 to 78. RANDBETWEEN will generate a new number each time you press Enter , 

or even when you use the UNDO or REDO functions (as long as youõre not altering any of the RANDBETWEEN 

cells) 

 

3. Select cell B2. Type in =A2*100  and press Enter  

 

 
 

Again, when you hit Enter, youõll notice that all values in cells A2 to A7 change to a new, random value  
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 13 

Quick Way Of Identifying Column Numbers For Use In A Vlookup Formula  

 
Question: I use formulas like VLOOKUP regularly. Is there a way to quickly work out what number a 

particular column is for these formulas?  

 

Answer: Yes, by chan ging an Excel option.  

 

Process (Excel 2003 and 2007):  

 

Formulas such as VLOOKUP and INDEX bring information from one table to another, and they require you to identify 

which column of information you would like to bring back.  

 

=VLOOKUP(lookup_value,table_a rray, COL_INDEX_NUM,[range_lookup)  

=INDEX(array,ROW_NUM,[column_num)  

 

http://www.alchemex.com/SubscribeNewsletters.aspx
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The COL_INDEX_NUM and the ROW_NUM in the above formulas will give you the number of the column rather than 

the letter. When you are dealing with a large number of columns, it is not alway s easy to see what number this column 

might be. This can be done by changing the R1C1 setting.  

 

Method: Excel 2007  

 

1. Click on the MS Office Button  in the top left corner of Excel, then select Excel options  

 

 
 

2. In the left hand pane, select the Formulas  opt ion, then click on the box next to R1C1 reference style  

 

 
 

This setting changes the column headings in Excel to numbers rather than letters  
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This will allow you to easily identify how many columns are in the ran ge for formulas such as VLOOKUP 

 

Method: Excel 2003  

 

1. On the Menu Toolbar, select Tools, then Options  

 

 
 

2. Select the General  tab, then place a tick in the R1C1 reference style  
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The column headings are now changed to number values rather than letters  

 

 
 

NB: make sure that you change this settin g back once you have finished building the formula  
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Using The Text Box To Enter Data  

 

Question: I want to put a lot of information into my spreadsheet, but I donõt want it to change the 

height of the entire row. How can I enter text without changing  the underlying cell or cells around it?  

 

Answer: By using a text box.  

 

Process (Excel 2003 and 2007):  

 

While you can put a lot of information into one cell in Excel, if you want to see that information all in one view can 

affect the width of the column an d the height of the row; this may not be good as it can alter how the rest o f the sheet 

is shown and make it unmanageable. 

 

An alternative to typing into a cell is using a Text Box . Here are a couple of tricks when using text boxes that can help 

make them easy to use. 

 

Excel 2007  

 

1. Select the Insert Tab  and then click on the Text Box button  

 

 
 

2. Your cursor will now resemble an inverted òtó. Click and drag across a range of cells 
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 You now have a text box with a flashing cursor in it  

 

3. Right click on the bo rder of the text box and select Size And Properties  

 

 
 

4. Select the Properties  tab, then select  Move but donõt size with cells, then click Close 
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This means that your text box will remain the same size and wonõt expand when more rows are added 

underneath the box.  

 

5. Right click on the text box border and select Format Shape é 

 

 
 

6. In the left hand menu, select Text Box , place a tick in the Resize shape to fit text  field and then click Close 
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When these two options are set, your text box will expand depend  on the amount of text you put in, but will not shift 

based on other cells being inserted or changing in size.  

 

Excel 2003  

 

In order to draw a text box in Excel 2003, you must have the Drawing  toolbar available. To see it, select View é 

Toolbars é Drawing from the Menu bar.  

 

1. From the Drawing toolbar, click the Text Box  button  

 

 
 

 

2. Your cursor will now resemble an inverted òtó. Click and drag across a range of cells 
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3. Right click on the Format Text Box  

 

 
 

4. Select the Properties tab and select the Move but donõt size with cells radio button  

 

 
 

5. Select the Alignment tab, place a tick the Automatic size  box, then click OK 

 

When these two options are set, your text box will expand depend on the amount of text you put in, but will not shift 

based on other cells being inserted or changing in size 
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Converting  Travel Distance V alues Into One Unit  

 
Question: I have people entering in travel distances onto a spreadsheet, but some people put in miles 

values and some put in kilometre values. How can I ma ke sure that all values are in kilometres?  

 

Answer: By using the CONVERT function  

 

Process (Excel 2003 and 2007):  

 

Firstly, an advisement: you will never cover every possible way that someone might enter the value ò20 kmó. It could 

be entered as ò20 kilosó, ò20kmó, ò20 kmó, ò20 kilometresó and every possible spelling mistake of those. The best 

option in this instance would be to have the number entered in one column, say, Column A, and then using a Data 

Validation list in Column B to select either òmió or òkmó, limiting how users enter the information and giving you 

something to work with (hoping they donõt type in òtwentyó instead of ò20ó) 

 

If you do manage to have people entering in information in a consistent was e.g. ò20 mió or ò20 kmó, hereõs how you 

could do it. Weõre going to use a table with six sample distances: 

 

 
 

1. Select cell B1. Type in =RIGHT(A1,2) and press Enter . This will tell you if the value in cell A1 is in miles or 

kilometres 

 

 
 

2. Select cell C1. Type in =LEFT(A1,LEN(A1)-3) and press Enter   
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The LEN() function returns the length of cell A1. By subtracting 3 from this amount (i.e. the letters and the 

space), you are left with the total number of characters for the value. This will mean youõll capture all 

numbers, regardless of how big and how many decimal places there may be.  

 

3. Select cell D1. Type in =CONVERT(C1,ómió,ókmó) and press Enter  

 

 
 

The CONVERT function changes the value from a miles value to a kilometres value ð the first option after the 

target cell ( C1) is the value to convert from, the second is the value to convert to. There are other conversion 

options that include weight and mass, distances, liquid measures and temperatures. Search in Excel Help for 

the CONVERT function to see a full list.  

 

4. Select cell E1. Type in =IF(B1=ómió,D1,C1) and press Enter  

 

 
 

The formula will check to see whether this is a òmió value and if so, return the kilometre value in D1, 

otherwise it will pull the original value from C1 

 

5. Highlight cells B1:E1 

 

 
 

6. Use the AutoFill Handle  and drag down to cell E6 
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This will fill al l of the formulas down to row 6  

 

 
 

For those who like to conserve space, the above could be accomplished in one, nested formula:  

 

=IF(RIGHT(A1,2)="mi",CONVERT(LEFT(A1,LEN(A1)-3),"mi","km"),LEFT(A1,LEN(A1) -3))  

 

 

NB: to use the CONVERT function in Excel 2003, you will need to have the Analysis ToolPak installed. This can be done 

by using the MS Office installation CD, customising the MS Excel installation option and ticking the box for the Analysis 

ToolPak. The function comes standard  with Excel 2007.  
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Limiting What Is Imported  Into Excel  
 

Question: When I import a text file into Excel, I donõt want to bring through every column of 

information. How can I limit what is imported?  

 

Answer: By changing your Text Import Wizard options  

 

Process (Excel 2003 and 2007):  

 

Some files that we use in Excel are saved in formats other than .XLS or .XLSX, such as .CSV (comma separated value) or 

.TXT (text) formats. This often h appens when information is being exported from a database, and you would now like 

to modify it in Excel. Excel can open these files and uses a Text  Import Wizard  to bring the data in.  

 

Sometimes, however, there is more information than you may require in f ile. How can you stop the Text  Import 

Wizard  from bring through unnecessary information? By changing some of the import options  

http://www.alchemex.com/Webinars.aspx























































































































































